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Challenge Image: Black & White 

In this lesson, we’re going to work on 
a challenge image submitted by one 
of our members and, in the process, 
we’ll learn some techniques related 
to black and white conversions. 

The image we’re working with is a 
jpeg, and it’s OK to use a jpeg as long 
as the brightest and darkest parts of 
the picture still contain some detail. 
Because we’re not starting with a 
raw file, we’re not going to use Cam-
era Raw. We’ll instead bring the im-
age directly into Photoshop. 

Remove all the color from the image

This particular image is a snowy scene that does not contain much color in the first 
place. Because there is so little color, we’ll start by pulling all of the color out, con-
verting to black and white by use of an adjustment layer. We’ll click on the Adjust-
ment Layer icon at the bottom of the Layers panel and choose Black & White from 
the pop-up menu. The Black & White adjustment layer will appear in the Layers 
panel and the Properties panel will display some sliders relating to the black and 
white layer. There will be sliders for each individual color and these sliders control 
the areas that used to contain the corresponding colors. For example, if we moved 
the Green slider to the left, all of the areas that used to be green would be dark-
ened. These sliders won’t be quite as useful for this image because there was not a 
lot of color to begin with. There was, however, a bit of a hue to the tree branches, 
and this area could be adjusted using the yellow and red sliders. We’ll play with 
those just a bit and then move on. 

Above is the original image.
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Make sure the image contains the full brightness range

The next thing we want to do is make sure that the image contains the full bright-
ness range. This will ensure that some part of the image contains solid white and 
another part of the image contains solid black. We’ll use a Levels adjustment layer 
to do this. We’ll again click on the Adjustment Layer icon at the bottom of the Lay-
ers panel and choose Levels from the pop-up menu. With the Levels adjustment 
layer active, the Levels histogram will appear within the Properties panel. The gra-
dient bar at the bottom of the panel displays all of the brightness levels that could 
possibly be contained in a picture. Above that is a bar chart (histogram) that shows 
us which of those brightness levels are contained in the active image. 

A Black & White adjustment layer is being used to remove all color from the image. The yel-
low and red sliders are being adjusted to fine tune the tone in the tree branches. 
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In our histogram, there are no bars on 
the left side of the chart and that means 
that there are no black tones in the pic-
ture. The darkest shade we have is the 
gray represented by the bars that appear 
farthest to the left. The opposite end of 
the histogram shows that the brightest 
shade is a light gray. There are no whites 
because the bars do not extend to the 
far right side of the chart. 

We’re going to take the brightest areas 
of the image and force them to become 
white by dragging the white slider on the 
chart to the left until it reaches the edge 
of the histogram bars. To get a better 
view of what areas are becoming white, 
we can hold down the Option key (Alt on 
Win) while dragging the white slider. This will give us a different and temporary 
view where the entire image is black except for the areas that are solid white. As we 
drag the slider more and more to the left, we’ll see more and more areas becoming 
solid white. We just want to drag the slider until we have a few specks of white. 
Any more than that and we will be losing detail in the snow. When we release the 
Option key, the image goes back to normal. 

Now, we’re going to do a similar thing on the left side of the histogram. The black 
slider will force more and more areas to black. We’ll drag this slider until it reaches 
the left side of the histogram bars and, again, we’ll hold down the Option key (Alt 
on Win) do get an alternate view of the image that shows us exactly what areas 
are becoming solid black. We’ll move the slider just until there are a few blobs of 
solid black. 

Looking at the histogram, we can see that 
there are gaps on the left and right sides. 
This means that we have no blacks or whites 
in the image.
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Using Shadows/Highlights to adjust the brightest/darkest areas

Now we have the full brightness range. At this point, I’d like to adjust the brightest 
and darkest areas of the picture. In many cases, I would use the Curves adjustment 
for this, but because this is a more sensitive image with such a large area of white, 
we’re instead going to use the Shadows/Highlights adjustment. Unfortunately, the 
Shadows/Highlights adjustment is not available as an adjustment layer. I want the 
Shadow/Highlight adjustment to be applied to the current image, including the 
results of the adjustment layers, so we’re going to have to do something special to 
achieve that. We’ll select all of the layers in the Layers panel and then we’ll click on 
the Layer menu at the top of the interface and choose Smart Objects > Convert to 
Smart Object. This will take all of the layers and convert them into a single smart 
object. 

We are moving the levels sliders in just enough so that we have a small amount of white and 
a small amount of black in the image. Holding down the Option key (Alt on Win) while drag-
ging the sliders gives us a view of the image that is shown above, indicating what areas of 
the image are becoming white or black (in this case).  
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In the Layers panel, it will look as if all the layers have been merged into one piece 
but we could still access the individual layers by double-clicking on the thumbnail 
for the smart object. Now that we have the smart object, we can click on the Image 
menu and choose Adjustments > Shadows/Highlights. 

The Shadows/Highlights dialog contains a series of sliders, and you can see more 
or less of these settings by toggling the “Show More Options” check box. The 
first thing we’re going to do here is drag the top two sliders (The Amount sliders 
for Shadows and Highlights) all the way to the left so that we’re not making any 
change to the image. Then, we’ll turn on the “Show More Options” check box (if it 
is not already turned on). These extra settings will give us more control over the 
process. We’ll start with the sliders at the bottom. The Black Clip and White Clip 
settings will force more and more areas to solid black and solid white. These will 
do the same thing that we previously did using the Levels adjustment. These set-
tings will be grayed out if the Amount sliders are all the way to the left, indicating 
that no change has been made to the image. Because I want the Black and White 
Clip settings to be available, I’ll move the Highlights Amount slider to the right just 
a smidge, so it’s at 1%. I don’t want to make a change. I just want the Clip settings 
to be available. We’ll set the Black Clip and White clip values to 0 (zero) because 
we’ve already done the work that these settings would do. We’ve just done it with 
more precision. 

Now we can start using the Shadows/Highlights settings to adjust the image. We 
want the large areas of snow to contain more detail and we can achieve this using 
the Highlights slider. As we bring up the Highlights Amount slider, the bright parts 
of the picture (the snow) will start to darken. We’ll move this slider to the right until 
we can start to see a good amount of detail in the bright portion if the picture. The 
Tone slider controls what tonal range is considered a highlight. If this slider is all the 
way to the left (at 0%), it’s going to make it so that only solid whites are consid-
ered highlights and, therefore, the Amount slider is not going to do much. As we 
move the Tone slider to the right, the shades that are considered to be highlights 
will encompass a larger and larger brightness range. We will try to find the highest 
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setting that doesn’t affect the other parts of the image (the parts that we don’t 
want to change). The Radius slider is going to determine how the changes made 
to the brightest parts of the image are going to blend into the rest of the image to 
look natural. We’ll play with this slider a bit, moving it left and right until we find the 
setting where we think it looks best. 

We can use the Shadows Amount slider to decide whether we want to brighten up 
any of the shadow areas in the image. The more we drag the Amount slider to the 
right, the lighter the shadows will become. We’ll more this slider up just a bit. Again, 
the Tone slider (for the Shadows) will determine what brightness range should be 
affected by the Shadows Amount slider. The higher the Tone setting, the more 
tones that will be considered to be shadows. We’ll move this slider up just so that 
the change affects the top of the image but not the table and chairs. The Radius 
slider is going to determine how the change that we’re making to the darkest part 
of the picture is going to transition into the rest of the image. 

The bottom-most slider in the dialog is going to control the brightness of the mid-
tones in the image. We’ll play with this, moving it back and forth to achieve a result 
that looks visually optimal.

The Shadows/Highlights adjustment is being used to control the brightest and darkest areas 
of the image. 
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The Color slider is not going to be relevant in our example because we have a black 
and white image, but if we were working with a color image, it would control how 
colorful the areas are that were changed by the Amount sliders. 

Once we’ve worked our way through all of the settings in the Shadows/Highlights 
dialog, we’ll click OK. In the Layers panel, we can click on the down-pointing arrow 
to the right of the smart object name and it will expand the list of adjustments that 
were applied to the smart object. We can see the Shadows/Highlights adjustment 
listed here. 

Refining the contrast with adjustment layers

We’ll now use a curves adjustment to control the contrast of the image as a whole. 
We want to do this with an adjustment layer so we’ll click on the Adjustment Layer 
icon at the bottom of the Layers panel and choose Curves from the pop-up menu. 
The Curves chart and settings will appear in the Properties panel and we want to 
use the Targeted Adjustment Tool, which looks like a hand icon on the left side of 
the panel. I like to keep my Targeted Adjustment Tool on by default, and you can 
specify this by clicking on the little menu in the top right corner of the panel and 
choosing “Auto-Select Targeted Adjustment Tool.” 

In adjusting the contrast, I want to control how dark the legs of the table are and 
how bright the top of the table is. To do that in Curves, we need two dots: one dot 
in the dark part where the legs are and another dot in the light part where the top 
of the table is. I’ll use the Targeted Adjustment Tool to click in these two areas, plac-
ing two points on the curve chart. These points represent the brightness range of 
the corresponding locations in the image. We’re going to take the lower of the two 
dots and drag it straight down. If the dot is highlighted, you can also use the up 
and down arrows on the keyboard to move it. We’ll drag it until we like the darkness 
level of the table and chair legs. We’ll do the same thing with the upper dot, moving 
it up until we like the level of brightness in the top of the table. 
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The contrast in the table and chairs is looking 
good now, but the Curves adjustment has 
resulted in the top of the image becoming 
too dark. That’s ok, though, because we can 
use the layer mask to hide the adjustment 
in certain areas. With the layer mask active, 
we’ll activate the Brush Tool and make sure 
that we’re using a large, soft brush. We’ll set 
the foreground color to black, which will 
hide the contents of the adjustment layer in 
the areas where we paint. We’ll paint over 
the top part of the picture, where the trees 
are, to remove the contrast effect that was 
created using the Curves adjustment. 

A Curves adjustment layer was created to increase the contrast in the table. At left, you can 
see the Properties panel for the  adjustment layer. Two points were placed on the curve, and 
those points were moved up and down to increase the contrast.

Here, we are painting on the layer mask 
for the Curves adjustment to remove the 
darkening effect from the background.
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We’ll now use a second Curves adjustment layer to brighten up the highlights in 
the background of the image. We’ll click again on the Adjustment Layer icon at the 
bottom of the Layers panel and we’ll choose Curves from the pop-up menu. Once 
again, the Curves chart and settings will appear in the Properties panel. We’ll place 
two dots in the image: one for the dark part of the background and another for the 
bright part. In this case, we want the brighter part of the background to become 
even brighter so we need to grab the upper of the two dots and move it up even 
farther. We’ll ignore the rest of the picture because we’ll use a layer mask to iso-
late the effect to the background. With the layer mask active, we’ll use a large, soft 
brush to paint with black over the foreground of the image. This will remove the 
Curves adjustment in all areas that we paint. 

Next, we want the table to stand out from the background even more and we’ll use 
yet another Curves adjustment layer for this. We’ll create a new Curves adjustment 
layer at the top of the layer stack and again make sure that the Targeted Adjust-
ment Tool is turned on. With this tool, we’ll click and drag down on the leg of the 
table, darkening it even further.  We can also click and drag up and down on the 
top of the table, adjusting it as well. 

Using the Targeted Adjustment Tool, we’re clicking and dragging down on the table leg. This 
is placing a point on the curve and moving it down in order to darken that tonal range. 
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We only want this change to affect the table and chairs so we’ll use the layer mask 
to hide the effect in the other areas. Because the parts of the layer we want visible 
are so small compared to the entire image, we’ll start with a completely black mask. 
With the mask active, we’ll go to the Image menu and choose Adjustments > Invert. 
This will switch the mask from being completely white to being completely black. 
We can now use a small, white brush to paint in the areas where we want the ad-
justment to be visible. This can be tricky because we need to be precise in covering 
the legs of the table and chair. Using too hard of a brush can make it obvious to see 
where we’ve painted. We’ll set the brush to a hardness of a little less than 50% so 
that we have a nice, semi-soft brush. 

When we start to paint on the layer mask, it’s such a subtle adjustment that makes 
it hard to tell where we’ve painted and where we haven’t. To make it more obvious, 
we can tap the backslash key ( \ ) in order to get a red overlay on the image that 
represents the mask. This is similar to the overlay we would have when using Quick 
Mask Mode. With this view, everything that has the overlay is hidden in the layer. 
We can now use the Brush Tool to add to the overlay (by painting with black) or 
remove from the overlay (by painting with white). If the foreground colors are set 
to black and white, we can quickly switch between the two by using the X key. 

With the layer 
mask active, 
we tapped the 
Q key to get 
this view of 
the mask. The 
overlay makes 
it easier to 
see what ar-
eas have been 
masked. Here, 
we’re painting 
with white to 
remove the 
mask from 
the top of the 
table.
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Using this overlay view will make it easier to be more precise when editing the 
mask and will make it easier to see what areas have been masked. We’ll paint with 
white over the table and chairs so that these are the only areas being affected by 
the adjustment layer. When it comes to masking fine details this way, the transition 
can look a little harsh when we’re painting with a really small or hard brush. One 
thing we can do to soften this transition is activate the Blur Tool and use it to paint 
over the area. When we’re done refining the mask, we’ll turn off the visibility of the 
red overlay by tapping the backslash key ( \ ) again. 

Now I would like to further adjust the snow but I don’t want the adjustment to af-
fect the table and chairs or the trees in the background. In order to isolate the snow 
area, we can take some of the layer masks that we’ve already created and then load 
them as selections. To do this, we’ll hold down the Command key (Ctrl on Win) and 
click on the thumbnail for the layer mask that isolates the table and chairs. This 
will create a selection of the table and chairs. We want to add to this selection to 
include the background area, so we’ll hold down the Command key (Ctrl on Win) 
AND the Shift key while clicking on the layer mask that isolates the background. 
Now we have both the table and the background selected. These are the areas that 
we DON’T want to affect, so we’ll select the opposite by going to the Select menu 
and choosing Inverse. 

We’ll click on the Adjustment Layer icon at the bottom of the Layers panel and 
choose Curves from the pop-up menu. This will add another Curves adjustment 
layer and the selection we had active will automatically be applied to the adjust-
ment layer’s mask, hiding the adjustment layer in all areas except for the snow. 

Using the Targeted Adjustment Tool, we’ll click to add a dot for the dark portion of 
the snow and we’ll click to add another dot for the bright portion of the snow. Now 
we can control those two areas by moving those dots on the Curves chart (within 
the Properties panel). We’ll move the upper dot a little higher to further lighten the 
highlights. We’ll keep the shadows where they are. Know that we’re not limited to 
adjusting just the highlights and shadows. We can also click and drag within the 
image to adjust a mid-tones as well.  
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Now I’d like to adjust the contrast in the chair. We’ll hold down the Command key 
(Ctrl on Win) while clicking on the thumbnail of the mask that has the table and 
chair isolated. This will create a selection of the table and chair. We want this new 
adjustment layer to appear at the top of the layer stack so we’ll make sure the top-
most layer is selected and we’ll click on the Adjustment Layer icon at the bottom 
of the Layers panel and choose Curves from the pop-up menu. When the Curves 
adjustment layer is created, the selection we had will automatically be applied to 
the layer mask. 

With this Curves adjustment, we added points for the highlights and shadows and we moved 
the highlights point up just a bit. We also adjusted the mid-tones by clicking and dragging up 
within the image. This placed a dot on the curve and moved it up as we dragged, lightening 
that tonal range. On the chart, you can see the three dots: one for the dark part of the snow, 
one for the lightest part of the snow, and one for an in-between shade.
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Using the Targeted Adjustment Tool, we’ll add two dots: one for the dark portion of 
the chair and another for the bright portion. When we click to add the dot for the 
bright portion, we’ll click and drag up in order to move the dot up on the Curves 
chart, brightening that tonal range. We’ll also drag down on the lower dot to dark-
en those shadow areas. 

Now we want to further isolate where this Curves adjustment is affecting the im-
age. We could continue to paint on the mask, but the mask is already quite detailed 
and we don’t want to risk messing it up. Instead, we’ll get a little tricky. With the 
Curves adjustment layer active, we’ll hold down the Shift key and then click on the 
folder icon at the bottom of the Layers panel. This will place the layer into a Group, 
or Folder (we use the names interchangeably). You can see that the layer becomes 
indented within the folder in the Layers panel. Now, with the folder active, we can 
click on the Layer Mask icon to add a mask to that folder. This mask will allow us 
to further control what areas of the adjustment layer will be visible. The mask is 
white and we’d like to start with a black mask so we’ll click on the Image menu and 
choose Adjustments > Invert. Now we can use a soft, white brush to paint on this 
mask, knowing that we will be unable to affect the areas that are already hidden by 
the mask attached directly to the adjustment layer. 

In order to further adjust the mask without messing up the mask that is already attached to 
the layer, we placed the layer inside a folder and are painting on the folder’s mask instead. 
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Adding a Vignette

Let’s add a vignette to the image. We’ll add a new Curves adjustment layer at the 
top of the layer stack and, within the Properties panel, we’ll drag the right side of 
the curve line down a bit. This will take all the white areas and make them a little 
more gray, dulling down the image. Then, we’ll activate the Brush Tool and make 
the brush REALLY large and soft. We’ll use the brush to paint in the areas where 
we want the viewer’s eye to go, mainly in the center of the image where the table 
and chairs are. This will remove the dulling effect on that area. 

The image has a vignette, but the dulling effect is a little obvious around the edges 
of the frame. To fix this, we’ll again get a little tricky by using a double mask. With 
the Curves adjustment layer active, we’ll hold down the Shift key and click on the 
folder icon at the bottom of the Layers panel. This will place the layer inside the 
folder. We’ll add a mask to the folder and use the Brush Tool, using a relatively hard 
edge, to paint with white in a few areas of the vignette. We’re doing this to make 
sure that a few areas, or objects, break through the dullness, making the vignette 
look less uniform and obvious. We’ll use a small brush to paint on a few of the 
branches in the background near the edge of the photograph. 

We added a vignette by dragging the light end of the curve down and then masking the cen-
ter of the image so the darkening only affected the edges of the frame.
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Adding a hint of color

After fine-tuning the black and white conversion, we might want to see how the 
image looks with a bit of color added. We’ll add a Gradient Map adjustment layer 
at the top of the layer stack. When adding this type of adjustment layer, the image 
may look odd to begin with, depending on what type of gradient was used last. To 
make the adjustment look normal, we need to change the blending mode of the 
layer to Color. This will make it so the adjustment can only affect the color of the 
picture and not the brightness. 

Next, we’ll go to the Properties panel and click on the arrow to the right of the gra-
dient preview. This will give us a menu of gradient presets. This menu will contain 
different presets depending on which ones were last loaded. We want a special 
set of presets, so we’ll click on the little gear icon and choose Photographic Toning 
from the pop-up menu. This set is idealized for adding a tinting effect to our pho-
tos. We can then click through the different presets to see how they look on the 
image. After choosing a preset, we might want to lower the opacity of the adjust-
ment layer to lessen the effect a bit. 

A tinting effect is being added to the image via a Gradient Map adjustment layer. In the  
Properties panel, we’re choosing between the various Photographic Toning presets. 


